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THE WINNING TEAM COLLECT THEIR PRIZE AT THE VERY SUCCESSFUL CHARITY TABLE QUIZ IN THE RATOATH INN.





LOTTO RESULTS 5- 12- 06


NUMBERS DRAWN 2,13,17,20.


NO JACKPOT WINNER                               THE €50 WINNERS WERE 


James Duncan c/o R.H.                        Paul Cambell c/o K. Brennan                          Tony McIntyre c/o K. Brennan               Eileen McMahon c/o T. Reilly


NEXT WEEKS JACKPOT IS €5000 AND THE DRAW WILL TAKE PLACE IN THE AULD STAND


(On duty M. Woods & J. Connor)

















Your By-line


Your Company Name


This document was created using linked text boxes, which allow articles to flow continuously across pages. For example, this article continues on page two, while the one to the right continues on page three. When you add lines of words to a text box, the words in the following text box flows forward. When you delete lines of words from a text box, the words in the next text box moves backward. You can link several text boxes in an article, and you can have multiple articles in a document. The links do not have to occur in a forward direction.


Inserting Linked Text Boxes


To insert linked text boxes in a document, click Text Box on the Insert menu. Click and drag in your document where you want to insert the first text box, and insert additional text boxes where you want the text to flow.


To select the first text box, move the pointer over the border of the text box until the pointer becomes a four-headed arrow and then click the border. Click the right mouse button, click Create Text Box Link and then click in the text box where you want the text to flow. Repeat these steps to create links to additional text boxes.


In the first text box, type text that you want. As the text box fills, the text will flow into the other text boxes that you’ve linked. To let the reader know that an article will continue on another page, insert a small text box under the text box, choose the Jump To style, and then type the words “Continued on Page.” Click Cross-reference on the Insert menu. Choose Heading from the Reference type drop-down list, and Page Number from the Insert Reference To. Select the name of the follow-up heading from the For Which Heading list box and then click Insert.


Formatting Text Boxes


You can change the look of linked text boxes by using color, shading, borders, and other formatting. Select the text box you want to format and then double click its border to open the Format Text Box dialog box. If you want to change the color or borders on a text box, choose the Colors and Lines tab. To change the size, scale, or rotation, click the Size tab. To change the position of the text box on the page, click the Position Tab.  If you have other text surrounding the text box, and want to change the way the text wraps around it, click the Wrapping tab. If you want to format all the text boxes in an article, you must format them individually - the formatting on one text box will not apply to the others in the sequence. 


Using Linked Text for Parallel Articles


You can use linked text boxes to flow text in parallel  “columns” from page to page. This method gives different results than using the Column command on the Format menu, which causes text in column 1 to flow or “snake” to column 2 on the same page. By using linked text boxes, you can instead have text from column 1 flow to column 1 on the next page. The text beside it in column 2 can flow to column 2 on the next page, parallel to column 1. This technique is useful if you need to group two similar articles, for instance, an article translated in English on the left and the same article translated in French on the right. 


To flow text in parallel, display paragraph marks in your document. Click at the top of the page where you want the side-by-side columns to start, and press Enter twice. Click in the first paragraph mark on the page. On the Insert menu, click Text Box and drag on the page where you want the first column. Click Text Box again and then click and drag where you want the second column. Click in the last paragraph mark on the page, and press Ctrl + Enter to create a page break.


Repeat the process for each page that will contain side-by-side columns in your document and then return to the first text box you created. Click the text box on the left once to select it. Click your right mouse button and then click Create Text Box Link. The pointer becomes a pitcher. Click the text box on the left side of the second page to create a link. Create links for all text boxes within the same article on the left side of the document. Repeat the process for every text box in the right chain or article.


Pressing Enter twice at the top of each page will create an extra empty paragraph. This blank paragraph is useful if you want to insert text or graphics outside of the text boxes. You can delete the extra blank paragraph if you don't need it.


Copying linked text boxes


You can copy an article or a chain of text boxes that are linked together, to another document or to another location in the same document. To copy linked text boxes and the text they contain, you must copy all the linked text boxes in an article. Select the first text box in an article. Hold down Shift, and click each additional text boxes you want to copy. On the Edit menu, click Copy. Click where you want to copy the text boxes and then click Paste.


To copy some of the text from  an article, select the text you want to copy from the article and then copy it. Do not select the text box. You can paste text you’ve copied directly into your document, into another location within the same article, or into another article.(





RATOATH      GARDEN  CENTRE


CHRISTMAS SHOP


 NOW OPEN


RATOATH ROAD ASHBOURNE


PH. 8256678








MANAGER REQUIRED





Ratoath Harps are currently looking for a manager for their reserve team.


The team plays in Div. 1c (Sat.) of the Leinster Senior League.         


For further information contact Brian Conway at 087-6888960





FIXTURES SUN. 11th  Nov.


Leinster Junior Cup


Ratoath Harps v Usher Celtic11oC. A


D.D.S.L.


8C v ?


9B1 v Lourdes Celtic 11-15 H


10A1 v Marino 12-30 A


N.D.S.L.


11B v Artane Beaumont 10oC.H


11E v Marino  10oC. H


12C v Mullingar 11oC. A


12E v  Swords Manor 11-15 H


13B v Santos 15 11-15 A


13D v Hartstown  11-15 A


14A v Kilbarrack 11-15 A


14D East Meath 12-30 H


15P v Dunshaughlin 11-15 H


15B v Dunshaughlin 12-30 A 


16A v ?


17A v Baldoyle 12-45 H





L.S.L.DIV. 2 (Tues. 13th Nov.)


Ratoath Harps v Railway Union 8pm H








L.S.L. DIV. 2





RATOATH HARPS 


V


RAILWAY UNION





SKRYNE ROAD FLOODLIT PITCH


TUESDAY   13TH  NOVEMBER


 K.O. 8 PM














FIXTURES SAT. 10th Nov.


L.S.L DIV. 3A


Ratoath Harps v Clonee 2oC. A


 


A.F.L. Seniors Div. 1A


Ratoath Harps v Chancery (Cup) 2oC A


D.D.S.L.


11A v Belvedere (Cup) 10-30 H 


12A v ?


13Major v Crumlin 11-30 H





N.D.S.L.


7A v  Balbriggan 10oC. A


8B1 v Mid Sutton 10=45 A


8E v Artane Beaumont 10oC. H


9C1 v  Clontarf 10-45 A


9D1 v Mid Sutton 11-45 H


10A v Rivervalley 10-45 A


10B1 v Swords Celtic 11-30 H


10D v Ratoath HarpsD(B) 12-45 H


10D(B) v Ratoath HarpsD 12-45 H





Ratoath have two teams in Div. 10 D and they play each other on Saturday











SIOBHAN AND DAVY O NEILL PLAY TO A RELATIVALY SMALL CROWD IN VERONICA BORDELLO DURING CHRISTMAS.





The Harp is an information leaflet produced by Ratoath Harps F.C. with the assistance of                          Philip Wallace & Oltech-Olivetti, National Distributors of copiers, fax, printers and supplies. 





L.S.L. MAJOR DIVISION (SUNDAY)


Ratoath Harps 1…..St. Josephs Boys 1, (Played Fri 2nd Nov. in Ratoath. K.O. 7-45)





Three weeks without a game was evident as Ratoath struggled to contain St. Josephs in the early stages of the game. Despite been on the back foot Ratoath should have taken the lead inside five minutes when Keith Scally went for power instead of placement and screwed his shot wide. Good defence from The Harps, especially Danny Lonergan and Ciaran Donnelly, restricted St. Joseph’s chances but they went close to taking the lead on a couple of occasions. Ratoath improved as the game progressed and almost took the lead five minutes before the break. A Barry Maguire header from a Chris Doran cross was well saved by the visiting keeper to leave the scoreline blank at half time. “Joeys” took the lead ten minutes into the second half with a powerfully headed goal and with things not going well up front for Ratoath it was going to need a bit of inspiration to gain something from the match.  The introduction of Damien O Neill and Brian Byrne brought a new urgency to the home teams play and they levelled with seven minutes remaining. Good work on the right by Damien O Neill and Mark Shannon created a chance for Danny Lonergan and he capped an outstanding performance with a great goal, his volleyed shot leaving the keeper flatfooted. Ratoath almost snatched a winner in the last minute when a Lonergan header cleared the bar but the 1-1 draw was probably a fair result. Danny Lonergan and Ciaran Donnelly were impressive at the centre of defence as Gareth Wilson and Mark Shannon took more control in midfield as the game progressed. 


Team; Gary Duff, David Geraghty, Danny Lonergan, Ciaran Donnelly, Paul Byrne, Barry Maguire, Gareth Wilson, Mark Shannon, Chris Doran, Keith Scally, Jordan Lancaster. Subs; Damien O Neill for Scally, Brian Byrne for Doran.





L.S.L. DIV. 2 (SATURDAY)


Ratoath Harps 1…..Griffith Rovers 1, (Played Sat. 3rd Nov. in Johnston Park, Finglas. K.O. 2-30)





Griffith Rovers had a one hundred percent record before this game but had to be content with a share of the spoils as Ratoath shrugged of a sluggish first half to dominate the second half. The Harps started well with Terry Whelan going close with a headed effort. Griffith began to take control but were thwarted by an outstanding Ratoath defence and half time arrived without the ball crossing the goal line.  The game was evenly balanced in the second half until Griffith took a 1-0 lead and Ratoath upped their game to dominate possession for the remainder of the game. The Harps were creating chances and went close on a number of occasions but bad luck and good goalkeeping kept them out. Time seemed to be running out but Alan Farrelly equalised for Ratoath with five minutes remaining when his well struck shot gave the keeper no chance, to finalise the scoring at 1-1.  Central defenders Colm Eglington and Hugh Kelly were best for Ratoath with Dylan Kiely, Andy Griffith and Brendan Kelly also playing well.


Team; Andrew Harte, Dylan Kiely, Colm Eglington, Hugh Kelly, Andy Griffith, Alan Farrelly, Brendan Kelly, Damien Lynch, Terry Whelan, Keith Scally, Mark Woods. Subs; Jonathan Drake for Scally, Conor Killian for Woods, John Moore for Lynch.








Ratoath Harps L.S.L. Div. 3A team were in action in the Leinster Junior Shield last Saturday against Crumlin team Rumms Rovers. They won this away tie 2-1 to enter the draw for the next round. Gary Hynes and Brian Snowe scored for The Harps





 MATCH REPORTS AND OTHER  NEWS ITEMS NEEDED FOR THE HARP








Ratoath soccer team 1962. Check it out at www.ratoathharps.com








A LITTLE THOUGHT





 When things in your life seem almost too much to handle, when 24 hours in a day are not enough, remember the mayonnaise jar and the coffee. A professor stood before his philosophy class and had some items in front of him. When the class began, wordlessly, he picked up a very large and empty mayonnaise jar and proceeded to fill it with golf balls. He then asked the students if the jar was full. They agreed that it was. So the professor then picked up a box of pebbles and poured them into the jar. He shook the jar lightly. The pebbles rolled into the open areas between the golf balls. He then asked the students again if the jar was full. They agreed it was. The professor next picked up a box of sand and poured it into the jar. Of course, the sand filled up everything else. He asked once more if the jar was full. The students responded with a unanimous "yes". The professor then produced two cups of coffee from under the table and poured the entire contents into the jar, effectively filling the empty space between the sand. The students laughed. "Now," said the professor, as the laughter subsided, "I want you to recognise that this jar represents your life. The golf balls are the important things -- your family, your children, your health, your friends, and your favourite passions -- things that if everything else was lost and only they remained, your life would still be full. "The pebbles are the other things that matter like your job, your house, your car. The sand is everything else -- the small stuff". "If you put the sand into the jar first," he continued, "there is no room for the pebbles or the golf balls. The same goes for life. If you spend all your time and energy on the small stuff, you will never have room for the things that are important to you. Pay attention to the things that are critical to your happiness. Play with your children. Take time to get medical check-ups. Take your partner out to dinner. Play another 18 holes. There will always be time to clean the house, and fix the disposal. Take care of the golf balls first, the things that really matter. Set your priorities. The rest is just sand". One of the students raised her hand and inquired what the coffee represented. The professor smiled. " I'm glad you asked," he said. "It just goes to show you that no matter how full your life may seem, there's always room for a cup of coffee with a friend."





























FROM THE ARCHIVES





Sunday 2nd November 1969 


Ratoath 2….Doreen Utd. 0





Ratoath fielded in the old fashioned “W M” formation which meant there were players called half backs and inside forwards. Noel Brown at right half back and Tom Ford at left half back were the stars for Ratoath as they defeated Doreen Utd. 2-0 in a Leinster Junior Shield game at Lagore. Goalkeeper Paddy Reilly kept his goals intact with the help of full backs Anthony and Ollie Reilly. The half back line was anchored by Glen Henry in the centre as Kevin White and Mick Donnelly filled the inside forward positions. Christo Ennis was at centre forward with the supply from the wings coming from Pat McDonagh and Shane White. Kevin White and Christo Ennis scored the goals and young sub Frank Reilly came on for a tired Shane White. Unfortunately there was no further glory in the Shield as they were beaten by that well known team Indonews a few weeks later in the Phoenix Park.





(Special thanks to Roddy O Neill for his well kept records)








PH. 8256396 OR 087-2444627


E-MAIL theharp68@gmail.com


WEBSITE: www.ratoathharps.com





LOTTO RESULTS 6-11-07





NUMBERS DRAWN


5, 6, 8, 11.





NO JACKPOT WINNER


THE €50 WINNERS WERE





Tommy Clince


Sandra Hoare


Michael & Marie Rooney


Chris Crowley


NEXT WEEKS JACKPOT IS


€5000


AND THE DRAW WILL TAKE PLACE TUESDAY NIGHT IN THE AULD STAND AT 10oC.


(On duty D. Keenan & T. Reilly.)





20th Nov. G. Doody & J. Tyrrell





RATOATH HARPS


(IN CONJUNCTION WITH THE M.D.L.)


SUPER DRAW


FOUR OPPORTUNITIES TO WIN A CAR             Tickets €20


First draw Wed. 19th  December 


STAR PRIZE EACH MONTH


HYUNDAI GETZ CAR 


OR €11,000 CASH


Plus many other prizes


Tickets available from club members








ATTENTION 


PLEASE NOTE NEW E-MAIL ADDRESS FOR THE HARP


theharp68@gmail.com


SEND IN ALL REPORTS, PHOTOS AND ANY OTHER ITEMS OF INTEREST AS EARLY AS POSSIBLE.








�











CREDIT UNION OF RATOATH


Phone 8257055         Fax 8257173


OPENING HOURS


Monday


 6.00 p.m. to 9.00 p.m.


Tuesday


 9.15 a.m. to 12.30 p.m.


Thursday


. 9.15 a.m. to 12.30 p.m.


2.00 p.m. to 4 p.m.


Friday


 9.15 a.m. to 12.30 p.m.


6.00 p.m. to 9.00 p.m.


Saturday


 10.30 a.m. to 12.30 p.m.
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